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IMPORTANT SAFETY INSTRUCTIONS 
 

 

The lightning flash with arrowhead symbol within an equilateral triangle is 
intended to alert the user to the presence of uninsulated “Dangerous voltage” 
within the product’s enclosure that may be of sufficient magnitude to constitute 
a risk of electric shock to persons. 

 

The exclamation point within an equilateral triangle is intended to alert the user 
to the presence of important operating and maintenance (Servicing) instructions 
in the literature accompanying the product. 

 
• Read these instructions 
• Keep these instructions. 
• Heed all warnings. 
• Follow all instructions. 
• Do not use this apparatus near water 
• Clean only with dry cloth. 
• Do not block any ventilation openings.  Install in accordance with the manufacturer’s 

instructions. 
• Do not install near any heat sources such as radiators, heat registers, stoves, or other 

apparatus (including amplifiers) that produce heat. 
• Do not defeat the safety purpose of the polarized or grounding-type plug.  A polarized plug has 

two blades with one wider than other.  A grounding-type plug has two blades and a third 
grounding prong.  The wide blade or the third prong is provided for your safety.  If the provided 
plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet. 

• Protect the power cord from being walked on or pinched particularly at plugs, convenience 
receptacles and the point where they exit from the apparatus. 

• Only use attachments/accessories specified by the manufacturer 
• Unplug this apparatus during lightning storms or when unused for long periods of time. 
• Refer all servicing to qualified service personnel.  Servicing is required when the apparatus has 

been damaged in any way, such as power-supply cord or plug is damaged, liquid has been 
spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or 
moisture, does not operate normally, or has been dropped. 

 

WARNING 
TO REDUCE THE RISK OF FIRE OR ELECTRIC – SHOCK, DO NOT EXPOSE THIS APPARATUS 
TO RAIN OR MOISTURE. 

WARNING 
DO NOT EXPOSE THIS EQUIPMENT TO DRIPPING OR SPLASHING AND ENSURE THAT NO 
OBJECTS FILLED WITH LIQUIDS ARE PLACED ON THE EQUIPMENT. 

WARNING  
TO COMPLETELY DISCONNECT THIS EQUIPMENT FROM THE AC MAINS, DISCONNECT THE 
POWER SUPPLY CORD PLUG FROM THE AC RECEPTACLE. 

WARNING  
THE MAINS PLUG OF THE POWER SUPPLY CORD SHALL REMAIN READILY OPERABLE. 



 

 

 
 

INFORMATION TO USERS IN EUROPE 
 

NOTE 
 

CISPR 22 CLASS A DIGITAL DEVICE OR PERIPHERAL 
 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to the European Union EMC directive.  These limits are designed to provide reasonable 
protection against harmful interference when the equipment is operated in a commercial environment.  
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio communications.  
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense. 

 
 
 
 
 
 

INFORMATION TO USERS IN THE U.S.A. 
 

NOTE 
 

FCC CLASS A DIGITAL DEVICE OR PERIPHERAL 
 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment.  This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications.  
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense. 

 
WARNING 

 
Changes or Modifications not expressly approved by Evertz Microsystems Ltd. could void the user’s 
authority to operate the equipment. 
 
Use of unshielded plugs or cables may cause radiation interference.  Properly shielded interface 
cables with the shield connected to the chassis ground of the device must be used. 
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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof nor 
for the rights of third parties, which may be effected in any way by the use thereof.  Any representations in this document concerning 
performance of Evertz products are for informational use only and are not warranties of future performance, either express or implied. The only 
warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order confirmation 
form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no 
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or 
order confirmation.  Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions.  If 
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make 
changes in equipment design or specifications. 
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1. OVERVIEW 

As broadcasters, cable companies, satellite providers and IPTV companies are moving toward an all 
digital domain, all distribution is done in the compressed domain. These service providers have a need 
for a bulk, easy to use, cost effective professional video decoder.  
 
The 3480DEC-MP2SD-ASI18 Series is a professional high quality bulk, high density MPEG-2 SD 
decoder.  It offers high end SD decoding of a signal coming from ASI input.  
 
The 3480DEC18-MP2SD-ASI18 series is perfect for monitoring applications or decoding for 
downstream baseband video and audio processing.   
 
The 3480DEC18-MP2SD-ASI18 Series can reconstruct in the most flexible way all VANC & HANC data 
in the SDI outputs.  

 
 

 
Figure 1-1: 3480DEC18-MP2SD-ASI18 
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2. INSTALLATION 

2.1. REAR PANEL 

The 3480DEC18-MP2SD-ASI18 rear panel is shown in Figure 2-1. 
 

 
Figure 2-1: 3480DEC18-MP2SD-ASI18 

 
ASI INPUTS (1-18):  ASI input per DVB TR 101 891-270Mb/s maximum bit rate 180Mb/s 
 
SDI OUTPUTS (1-18): Eighteen BNC serial digital video outputs are present.  Each output corresponds 

to a specific decoder.  For example, Output 1 is connected to Decoder 1, 
Output 2 is connected to Decoder 2, and so on.  The output standard is 525 
(NTSC) or 625 (PAL).  

 
UPGRADE:   A 9 pin female ‘D’ connector for connection to the RS-232 serial 

communications.  This port is configured for a ‘straight through’ RS-232 
connection to a PC COM port and can be used for uploading firmware, and 
updating/changing the units IP address. Table 2-1 shows the pin out of the 
serial port in its default RS-232 DCE configuration.  

 
PIN # Name Description 

1   
2 TxD RS-232 Transmit Output  
3 RxD RS-232 Receive Input 
4   
5 Sig Gnd RS-232 Signal Ground 
6   
7 RTS RS-232 RTS Input 
8 CTS RS-232 CTS Input 
9   

Table 2-1: Pin Out for Serial Port (Default RS-232 DCE Configuration) 
 

2.2. CONNECTING THE DECODER TO AN ETHERNET CONNECTOR 

The decoder is designed to be used with either 10Base-T (10 Mbps) or 100Base-TX (100 Mbps) also 
known as Fast Ethernet, twisted pair Ethernet cabling systems.  When connecting for 10Base-T 
systems, category 3, 4, or 5 UTP cable as well as EIA/TIA – 568 100Ω STP cable may be used.  
When connecting for 100Base-TX systems, category 5 UTP cable is required.  The cable must be 
“straight through” with a RJ-45 connector at each end.  Make the network connection by plugging one 
end of the cable into the RJ-45 receptacle of the decoder and the other end into a port of the 
supporting hub. If you are connecting the decoder directly to a PC, then you will have to use a 
crossover cable. 
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The straight through RJ-45 cable can be purchased or can be constructed using the pinout information 
in Table 2-2.  A colour code wiring table is provided in Table 2-2 for the current RJ-45 standards 
(AT&T 258A or EIA/TIA 258B colour coding shown). Also refer to the notes following the table for 
additional wiring guide information.  
 

Pin # Signal EIA/TIA 568A AT&T 258A or 
EIA/TIA 568B 

10BaseT 
or 100BaseT

1 Transmit + White/Green White/Orange X
2 Transmit – Green/White or White Orange/White or Orange X
3 Receive + White/Orange White/Green X
4 N/A Blue/White or Blue Blue/White or Blue Not used (required)
5 N/A White/Blue White/Blue Not used (required)
6 Receive – Orange/White or Orange Green/White or Green X
7 N/A White/Brown White/Brown Not used (required)

Pin 1 

 

8 N/A Brown/White or Brown Brown/White or Brown Not used (required) 

Table 2-2: Standard RJ45 Wiring Colour Codes 

 
Note the following cabling information for this wiring guide: 

• Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals. 
• Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable. 
• 10BaseT and 100BaseT use the same pins, a crossover cable made for one will also work with 

the other. 
• Pairs may be solid colours and not have a stripe. 
• Category 5 cables must use Category 5 rated connectors. 

 
The maximum cable run between the decoder and the supporting hub is 300 ft (90 m).  The maximum 
combined cable runs between any two end points (i.e. decoder and PC/laptop via network hub) is 675 
feet (205 m). 
 
Devices on the Ethernet network continually monitor the receive data path for activity as a means of 
checking that the link is working correctly.  When the network is idle, the devices also send a link test 
signal to one another to verify link integrity. The decoder rear panel is fitted with two LEDs to monitor 
the Ethernet connection.  
 
10/100: This amber LED is ON when a 100Base-TX link is last detected.  The LED is OFF when a 

10Base-T link is last detected (the LINK LED is ON). Upon power-up the LED is OFF as the 
last detected rate is not known and therefore defaults to the 10Base-T state until rate 
detection is completed.  

 
LN/ACT: This dual purpose green LED indicates that the decoder has established a valid linkage to 

its hub, and indicates whether the decoder is sending or receiving data.  This LED will be 
ON when the decoder has established a good link to its supporting hub.  This gives you a 
good indication that the segment is wired correctly. The LED will BLINK when the decoder is 
sending or receiving data. The LED will be OFF if there is no valid connection. 

 
Once you have established a valid link you will have to set up the network I/P address for the decoder.    
When you have set up the I/P addresses you should be able to ‘ping’ each of the devices in the system.   
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2.3. POWER CONNECTIONS 

The 3480DEC18-MP2SD-ASI18 has two universal power supplies (main and backup) that operate on 
either 100-115 or 220-240 volts AC at 50 or 60 Hz and automatically sense the input voltage.   Power 
should be applied by connecting a 3-wire grounding type power supply cord to the power entry modules 
on the rear panel.  
 

2.3.1. Changing the Fuses 

 
Check that the line fuse is rated for the correct value marked on the rear panel.  
Never replace with a fuse of greater value.  

 
The fuse holder is located inside the power entry module.  To change the fuses, pull out the fuse holder 
from the power entry module using a small screwdriver.  The fuse holder contains two fuses, one for 
the line and one for the neutral side of the mains connection.  Pull out the blown fuse and place a fuse 
of the correct value in its place.  If the fuse blows, replace with a fuse of the correct type only in this 
case T3.15AL250V; Use of any higher amperage value will void the warranty.  
 

 

NOTE: Fuses are for your protection. Never substitute a fuse of a higher rating, or 
bypass it.  
 
NOTE:  The fuse will not blow unless the unit is overstressed.  Before replacing the 
fuse, correct the condition that caused it to fail.  

 

2.4. MOUNTING 

To successfully install the 3480DEC18-MP2SD-ASI18: 
 

1. Unused IP address on the network or a DHCP server 
2. Serial cable 
3. VLPro Server IP address 

 
The 3480DEC18-MP2SD-ASI18 is equipped with rack mounting angles and fits into a standard 19 inch 
by 1 ¾ inch rack space.  
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2.4.1. Accessing the Serial Port Menu 
Connect a serial cable to the UPGRADE port at the back of the unit. Do not connect any cables to the 
rear card (failure to do this could cause unwanted network issues) until the initial configuration has 
been completed.  Connect the 9-pin d-type end of the serial cable to the serial port of your computer. 
Open a Terminal session and configure the port for the following configuration:  
 

 

 
 

 
 

Figure 2-2: COM Properties Window  

 
Figure 2-3: COM1 Properties 

 
Click OK to apply these settings and press the <enter> button. The session should respond with the 
3480DEC18-MP2SD-ASI18 Main Menu as shown in Figure 2-4: 
 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 
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Figure 2-4: HyperTerminal Main Menu 

 
(1) Network Configuration 
This sub-menu enables the user to configure the network settings for the card. 
 
(2) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community 
strings. 
 
(3) XPT Menu  
This sub-menu is used to configure the decoder parameters. As this configuration can also be 
performed via VLPro this sub-menu will not be covered in this section. 
 
(4) Decoder Menu 
This sub-menu contains two utilities. One command is for clearing the memory, and the other for 
clearing the flash. In normal operation it should not be necessary to use either of these options. 
 
(5) Engineering Debug Utility 
This menu is for Evertz personnel only. You may be requested to access and execute options within 
this menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic 
network settings via the serial cable; this configuration is described in section 2.5. 
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2.5. CONFIGURING THE BASIC NETWORK SETTINGS 

Select option (1) Network Configuration, the Network Configuration menu will be displayed as shown in 
Figure 2-5. If you prefer to use DHCP then you may select option (5) Use DHCP, and then continue 
from step 4: 
 

1. Select option (1) Set IP Address and configure the IP address for the 3480DEC18-MP2SD-
ASI18 ensuring that the IP address is not already in use on the network.  

2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.  
3. If required also configure option (3) Set Gateway.  
4. Exit from the Network Configuration menu using (s) Save and Exit, NOT (x) Exit. 

 

 
Figure 2-5: Network Configuration Sub-Menu 

 
From the Main Menu select option (2) SNMP Configuration. Normally it is only necessary to configure 
option (1) Set IP Address, and enter here the IP address of your VLPro Server.  Exit using option (S) 
Save and Exit.  Now extract the card from the rack, remove the serial cable and re-insert it. 
 
You have now completed the necessary minimum configuration and can connect the cables to the rear 
of the card when ready. 
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2.6. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the 3480DEC18-MP2SD-ASI18 jar file to the server and both the client 
and server applications have been restarted. If you are the network administrator refer to section 5.2 for 
information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” symbol. 
Your 3480DEC18-MP2SD-ASI18 should appear as a newly listed device with the IP address used to 
configure the card in Step 1 above. It may take up to a minute to appear while the card and switch 
negotiate network settings (this can be verified directly on the switch if necessary). 
 
Listed below the 3480DEC18-MP2SD-ASI18 IP address will be two sub-menu ASI inputs and 
Decoders.  
 

 
Figure 2-6: VistaLINK® PRO Hardware Configuration 

 

 

Note: If after a couple of minutes the card has still not appeared try selecting 
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used 
in the configuration stage earlier and select OK.  The card should now be listed 
and will remain greyed out for a moment while VLPro finds the card and 
confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
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3. CARD CONFIGURATION 

The 3480DEC18-MP2SD-ASI18 has three different types of menus:  
1) Root Menu: Present card type and FPGA monitoring parameters.  
2) ASI Inputs Menu: Each one of the eighteen ASI inputs has its own menu for monitoring 

and alarming capabilities.  
3) Decoders Menu: Each one of the eighteen decoders has its own menu for ASI input 

selection, program tuning, alarming … etc.  
 

3.1. ROOT MENU 

Right click the IP address (selected earlier) of the 3480DEC18-MP2SD-ASI18 and select “View 
Configuration”. The configuration page will open; this page contains two different tabs General and 
FPGA Monitor.   
 

3.1.1. General Tab 
The General tab provides the product name of the selected device.   
 

 
Figure 3-1: General Tab 

 
3.1.2. FPGA Monitor TAB 
The FPGA Monitor tab provides a reading of the FPGA current core temperature. These values can be 
used for engineering troubleshooting purposes.   
 

 
Figure 3-2: FPGA Monitor Tab 
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3.2. ASI INPUTS 

Click the ‘+’ sign next to the IP address, followed by the ‘+’ sign next to ASI Inputs to view the eighteen 
ASI inputs that are present.  For simplicity a description of one of the inputs will be provided, this 
description applies to all eighteen different ASI inputs. Right click Input 1 and select view configuration. 
 
This configuration window is divided into 6 different tabs, the following sections 3.2.1 to 3.3.4 provide 
detailed descriptions of each tab.  
 
3.2.1. PID Monitor Tab 
The PID Monitor tab is where VLPro displays the standard Transport Stream parameters. As shown in 
Figure 3-3 it is possible to see a basic view of most of the packets within the TS stream. They are 
organized in ascending order by Service ID but can also be re-ordered by Prog #. This can be done by 
double clicking the column header, make sure you are not in the auto refresh mode when doing this. 
 

 
Figure 3-3: VistaLINK® PRO – PID Monitor 

 
For each individual PID it is possible to view its type and encoding standard.  

 
 

 
Note: The PID Monitor is a dynamic view; by clicking the auto refresh button it is 
possible to see near instantaneous values for the stream. 
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3.2.2. ASI Input Monitor 
This tab reports back the Input state, Number of programs present and the Transport stream ID.   
 

• Input State: Displays either Active or Inactive, this shows the state of the current input.  An 
input is active if a sync byte (x47) can be detected, otherwise it is considered inactive.  

 
• Number of Programs: This field displays the number of programs present within the PAT. 

 
• Transport Stream ID: This field displays the transport stream ID as it appears within the PAT.  

 

 
Figure 3-4: ASI Input Monitor Tab 

 

3.2.3. ASI Input Control 

• Expected TS ID: Enter here the expected transport stream ID, this number is checked against 
the transport stream ID displayed under the ASI Input Monitor tab, if the numbers do not match 
an alarm will be set.  

 
• Expected Num Programs:  Enter here the expected number of Programs, this number is 

checked against the transport stream ID displayed under the ASI Input Monitor tab, if the 
numbers do not match an alarm will be set.  

 
• Input Mode Select: Options available are ATSC, DVB and MPEG.  

 
It is important to select the standard to which the stream is being coded as this affects the context of 
the alarms for ETSI TR 101 290 priority 3 and the handling of AC3 Audio. 
 

 
Figure 3-5: ASI Input Control 
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3.2.4. ASI Faults 

This tab is divided into two windows: Faults and Trap Enable. 

3.2.4.1. Faults  

• TS Sync Error: The presence of the sync byte (x47) is monitored here, this indicator will stay 
green as long as a sync byte is present, if a sync byte cannot be detected this indicator will turn 
red.  

 
• TS ID Error: This indicator checks the TS ID present within the PAT against the value entered 

by the user under the ASI Input Control tab; if the values match the indicator will remain green, 
otherwise it will turn red. 

 
• Number of Programs:  This indicator checks the Number of Programs present within the PAT 

against the value entered by the user under the ASI Input Control tab; if the values match the 
indicator will remain green, otherwise it will turn red. 

 
• ASI Fault Condition 1:  The conditions that will trigger this indicator can be configured under 

the ASI Fault Trigger.  
 

3.2.4.2. Trap Enable 
Using the trap enable section the user can enable or disable traps from being sent.  To enable any of 
the traps/alarms simply click the check box that corresponds to the alarm you wish to enable.  
 

 
Figure 3-6: ASI Faults 
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3.3. DECODER 

Click the ‘+’ sign next to the IP address, followed by the ‘+’ next to Decoders to view the eighteen 
Decoders that are present.  For simplicity a description of one of the decoders will be provided, this 
description applies to all eighteen different decoders. Right click Decoder 1 and select view 
configuration from the drop down menu. 
 

 
Figure 3-7: Decoder Window 

 
This configuration window is divided into 8 different tabs, below is a detailed description of each tab. 
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3.3.1. Input Select 
The input selection tab is used to select the input in use. There are eighteen different inputs, all of 
which are routable to any of the decoders.  In order to select an input simply click on ASI Input 1, and a 
drop down menu will appear as shown in Figure 3-8.  Once a selection is made click the apply button.   
 

 
Figure 3-8: Decoder Input Select Drop Down Menu 
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3.3.2. Program Tuning 

 
Figure 3-9: VistaLINK® PRO – Program Tuning 

 
• Program Tuning Mode: Options are Auto, Program Select or PID Select.  

o Selection of Auto will set the decoder to decode either the first program in the PAT or the 
lowest program number; this can be selected using the next configuration option below.   

o Program Select allows the user to define the program number, PCR, video and audio 
selection is automatic based upon the PMT.   

o PID Select allows the user to define the PCR, Video and up to four audio by their PID 
numbers, the PMT PID is ignored. 

 
• Auto Program Select Mode: Options are First Program in PAT or Lowest Program Number. 

o First program means that the first program is defined within the PAT. 
o Lowest program number will select the program with the lowest Program ID. 
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• Program Number: When the Program Tuning mode is set to Program Select, enter here, in 
decimal form, the Program ID. 

 
• Video PID Number: When the Program Tuning mode is set to PID Select, enter here, in 

decimal form, the Video PID ID. 
 

• PCR PID Number: When the Program Tuning mode is set to PID Select, enter here, in decimal 
form, the PCR PID ID. 

 
• Audio 1 PID Number: When the Program Tuning mode is set to PID Select, enter here, in 

decimal form, the first Audio PID ID. 
 

• Audio 2 PID Number: When the Program Tuning mode is set to PID Select, enter here, in 
decimal form, the second Audio PID ID. 

 
• Video Delay:  Sets the video delay through the 3480DEC18-MP2SD-ASI18.  Here you may 

delay your video for up to 15 frames.  
 

• Audio 1/2 Delay: The 3480DEC18-MP2SD-ASI18 automatically embeds the selected audio 
streams into the outgoing SDI. It is possible to add an additional delay to synchronize the audio 
and video stream. Simply slide the audio delay to the desired setting for each audio group. The 
maximum delay is 2000ms. 

 
• Video Locking:  This field determines the video locking mechanism.  The locking options are 

PTS (Presentation Time Stamp) or VBV (Video Buffering Verifier). By default PTS will be 
selected.  

 
• Audi 1/2 type select:  When Program Tuning Mode is set to PID Select the user must specify 

the type of audio present, in all other cases this option will be disabled.  
 
• AC3 Audio 1/2 Mode: The 3480DEC18-MP2SD-ASI18 gives the user the option to decode or 

bypass the AC3 audio.  The user may select here to Bypass or Decode the AC3 audio.  
 

• Decoder Reset: This option allows the user to perform a soft rest on each decoder, this can be 
used in case a particular decoder fails and the user wishes to rest it without having to reboot the 
unit.  In order to perform a soft rest, select Rest from the drop down menu and click apply.  

 

 
Note: MPEG 1 Layer II audio will always be decoded. 

 
 

 
NOTE: When Program Tuning Mode is set to PID Select, it is possible to select any 
audio from any service with the transport stream.  
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3.3.2.1. Decoder Output Control: 

• CC Embed Enable: This allows the user to decide if Closed Caption 608 should be embedded 
on the output, by default this is disabled. 

 
• CC Embed Line:  This allows the user to select the line at which the closed captions will be 

embedded; the range is line 7 to 21. 
 

• Vertical Start Location: Currently not supported at this time.  
 

• Horizontal Resize Mode:  Currently not supported at this time. 
 

• Horizontal Start Location   Currently not supported at this time. 
 

3.3.3. Program Info 

 
Figure 3-10 VistaLINK® PRO – Program Info 

 

3.3.3.1. Program Monitor  

• Program Number in TS: The currently decoded Program ID is displayed in this field in Decimal 
form.  

 
• PMT PID: The currently decoded Program Map Table Packet ID is displayed in this field in 

Decimal form.  
 

• PCR PID: The Program Clock Reference Packet ID is displayed in this field in decimal form.  
 

• Num Video Streams: The number of video streams within the program is displayed in this field. 
 

• Num Audio Streams: The number of audio streams within the program is displayed in this field. 
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3.3.3.2. Video Monitor 

• Video PID Number: The currently decoded Video Packet ID is displayed here in Decimal form.  
 

• Video Bit Rate: The current video bitrate is displayed in this field. This value will be variable for 
video encoded in VBR. 

 
• Video Resolution: The currently decoded video resolution will be displayed in this field. This is 

read from the PSIP/PSI. 
 

• Video Profile and Level: The currently decoded video profile will be displayed in this field.  This 
is read from the PSIP/PSI. Currently the 3480DEC18-MP2SD-ASI18 supports MP@ML. 

 
• Video Chroma Format: The currently decoded video resolution will be displayed in this field. 

This is read from the PSIP/PSI. This will either be 4:2:0 or 4:2:2. 
 

3.3.3.3. Audio 1/2 Monitor 

• Audio PID Number: The currently decoded Audio Packet ID is displayed here in Decimal form. 
 

• Audio Bit Rate: The current Audio bitrate is displayed in this field. 
 

• Audio Type: The currently decoded video resolution will be displayed in this field.  This is read 
from the PSIP/PSI.  

 
• Sampling Rate: The currently decoded Audio Sampling rate will be displayed in this field; this is 

read from the PSIP/PSI. 
 

• Num Channels: The number of channels of Audio in the currently decoded program will be 
displayed in this field. This is read from the PSIP/PSI. 

 

3.3.4. Output Audio 

3.3.4.1. Audio Control 

• Group 1/2/3/4: The 3480DEC-MP2SD-ASI18 automatically embeds the selected audio streams 
into the outgoing SDI. Here it is possible to re-arrange the audio streams and/or embed other 
separate audio streams. From the drop down menu, simply select for each Group which Audio 
should be embedded. 

 

 
Figure 3-11: Output Audio 
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4. TECHNICAL SPECIFICATIONS 

4.1. INPUTS AND OUTPUTS 

• ASI Input per DVB TR 101 891-270Mb/s Maximum Bitrate 180Mb/s 
 
• 18 SDI 270Mb/s SMPTE 259M 

 
 

4.2. DECODING SPECIFICATIONS 

VIDEO: 
SD Encoded  
Standard Supported: MPEG-2 Main Profile @ Main Level  
 
Video Format:  Standard Definition 525 (NTSC) and 625 (PAL) 

 
 

4.3. AUDIO DECODER 

• MPEG-1 Layer 2 Audio Decoder 
 
 

4.4. EMBEDDING OF HANC & VANC 

• Decoded Audio 
• Audio Pass Through, AC-3 
• Closed Caption 

 
 

4.5. AC-3 DECODING OPTION (+18AC3-2C) 

• 18xAC-3 decoder with downmix (2 channels output) embedded in SDI output 
 
 

4.6. AUDIO VIDEO MONITORING (+AVM) 

• Black, freeze, video presence, audio presence 
 
 

4.7. A/V LEVEL ADJUSTMENT (+PROC) 

• Luminance, chrominance, audio level adjustment 
 
 

4.8. INTELLIGAN (+IG) 

• Dynamic audio loudness & levels adjustment 
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5. TROUBLESHOOTING 

5.1. VLPRO DOES NOT DISPLAY THE 3480DEC18-MP2SD-ASI18 ALARMS 

Once a connection has been establish check and/or configure the SNMP settings with the correct 
VLPro Server IP address and ensure the community strings are correctly set. Refer to the network 
administrator if you are in doubt as to what these should be set to. 

 

5.2. UPDATING VLPRO SERVER JAR FILE  

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancements. It 
will also be necessary to add JAR files for new products. If your new product has not appeared even 
after waiting a few minutes for the Ethernet switch negotiation to complete then it is possible that your 
JAR file may be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 5-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 5-2, simply navigate to the location of the new JAR file and 
select the file by double clicking it. The window will automatically close and the update will be applied in 
the background.  
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Figure 5-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied. 

 

 



3480DEC18-MP2SD-ASI18 
High Density MPEG-2 SD Decoder 

Page 22 Revision 0.1  

6. ABBREVIATIONS 

For the purposes of the present document, the following abbreviations apply: 
 
BAT Bouquet Association Table 
BER  Bit Error Rate 
BW  Band Width 
CA  Conditional Access 
CAT Conditional Access Table 
CPE Common Phase Error 
CRC  Cyclic Redundancy Check 
ETSI European Telecommunications Standards Institute 
DC  Direct Current 
DVB  Digital Video Broadcasting 
DVB-C  Digital Video Broadcasting baseline system for digital cable television (EN 300 429 [6]) 
DVB-CS  Digital Video Broadcasting baseline system for SMATV distribution systems (EN 300 473 

[13]) 
DVB-S  Digital Video Broadcasting baseline system for digital satellite television (EN 300 421 [5]) 
DVB-T  Digital Video Broadcasting baseline system for digital terrestrial television (EN 300 744 

[9]) 
EIT  Event Information Table 
ETR  ETSI Technical Report 
ETS  European Telecommunication Standard 
FEC  Forward Error Correction 
GOP Group of Pictures 
HEX  Hexadecimal 
ISO  International Organization for Standardization 
ITU  International Telecommunication Union 
MGT Master Guide Table 
MPEG  Moving Picture Experts Group 
NIT  Network Information Table 
PAT  Program Association Table 
PCR  Program Clock Reference 
PID  Packet Identifier 
PMT Program Map Table 
PSI  MPEG-2 Program Specific Information (as defined in ISO/IEC 13818-1 [1]) 
PSIP Program and System Information Protocol 
PTS  Presentation Time Stamps 
RS  Reed-Solomon 
RST  Running Status Table (see EN 300 468 [7]) 
RTE Residual Target Error 
SDT  Service Description Table 
SI  Service Information 
TDT  Time and Date Table 
TOT  Time Offset Table 
TS  Transport Stream 
UTC  Universal Time Co-ordinated 
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